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1. Einleitung

Vielen Dank, dass Sie sich für ein Produkt aus unserem Hause entschieden haben. Bitte
lesen Sie sich vor Inbetriebnahme die Gebrauchsanweisung sorgfältig durch, damit ein
störungsfreier Betrieb gewährleistet ist. Als Anwender der Software haben Sie nun ein
sehr vielseitiges und hochprofessionelles Werkzeug an der Hand, das Ihnen, bei richtiger
Bedienung, viel Freude bescheren wird.

1.1 Symbole im Benutzerhandbuch

Warnung

Dieses Symbol bedeutet eine möglicherweise drohende Gefahr für das Leben und die
Gesundheit von Personen. Das Nichtbeachten dieser Hinweise kann schwere gesundheitliche
Auswirkungen zur Folge haben, bis hin zu lebensgefährlichen Verletzungen.

Vorsicht

Dieses Symbol bedeutet eine möglicherweise gefährliche Situation. Das Nichtbeachten dieser
Hinweise kann leichte Verletzungen oder Sachbeschädigungen zur Folge haben.

Dieses Symbol gibt wichtige Hinweise für den sachgerechten Umgang mit den beschriebenen
Produkten. Das Nichtbeachten dieses Hinweises kann zu Funktionsstörungen oder
Sachschäden führen.

Tipp

Dieses Symbol gibt Hinweise für den einfacheren Umgang mit den beschriebenen Produkten.

1.2 Informationen über dieses Benutzerhandbuch

Sämtliche Angaben in diesem Benutzerhandbuch basieren auf den zum Zeitpunkt der
Drucklegung verfügbaren Informationen über die Eigenschaften der hier beschriebenen
Produkte und den entsprechenden Sicherheitsvorschriften.

Der Hersteller behält sich Änderungen und Modifikationen im Rahmen der gesetzlichen
Bestimmungen sowie die Verbesserung der Produkteigenschaften ausdrücklich vor.

Dieses Benutzerhandbuch und alle weiteren notwendigen Informationen zum sicheren
Gebrauch müssen allen Personen, die den Verstärker benutzen, zum Zeitpunkt des Auf-
und Abbaus und während des Betriebs verfügbar sein! Ohne dieses Benutzerhandbuch
gelesen, verstanden und griffbereit vor Ort zu haben, darf das Zubehör weder aufgebaut
noch eingesetzt werden.

Wir freuen uns über Anregungen und Verbesserungsvorschläge zu diesem Benutzerhandbuch.
Bitte schicken Sie diese an folgende Adresse:

info@kling-freitag.de oder an:

KLING & FREITAG GmbH, Junkersstr. 14, D-30179 Hannover

Telefon 0511 - 96 99 70, Telefax 0511 - 67 37 94.
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2. Allgemeine Informationen

2.1 Umfang dieser Anleitung

Dieses Handbuch bezieht sich auf die Software zur Fernsteuerung der CD 44 Systemcontroller
per PC-Software (Remote-Software). Soweit die Controller unterschiedliche Funktionen
aufweisen, wird dies gesondert vermerkt.

Dieses Handbuch ergänzt die Anleitung, die mit dem Controller selbst ausgeliefert wurde
(Hardwareanleitung). Deshalb finden Sie hier keine ausführlichen Beschreibungen der
einzelnen Charakteristiken (z.B. der Filter). An den jeweiligen Stellen finden Sie Hinweise auf
die entsprechenden Stellen im Hardwarehandbuch. Zusätzliche Funktionen, die nur über die
Software zur Verfügung stehen, sind hier ausführlich beschrieben.

Vorsicht

Beachten Sie auf jeden Fall das Kapitel „Allgemeine Sicherheitshinweise“ in der
Hardwareanleitung für K&F CD 44. Dies gilt insbesondere für die Anschlüsse und den
Aufstellort des Controllers.

2.2 Begriffe

Complete
Funktion, mit der eine Sicherungskopie aller Controllerdaten (Complete-Backup) erstellt
werden kann. Dateiendung *.dcc.

EQ-Set
Einstellungen der grafischen Equalizer, die seperat gespeichert und geladen werden können.
Dateiendung *.dec.

Firmware
Die Software, die im Controller installiert ist, wird in diesem Handbuch als „Firmware“
bezeichnet.

Funktionsblöcke
Der CD 44 verfügt über verschiedene Funktionen, die Funktionsblöcke genannt werden:
• Grafische Equalizer

• Input Gains

• Input Delay

• Limit Reduction

• Output Gain

• Output Delay

Input-Patching
Mit dem Input-Patching können Sie die physikalischen Eingänge konfigurieren. So können Sie
z.B. physikalisch vertauschte Eingänge im Controller zurück tauschen ohne die eigentlichen
Stecker ändern zu müssen. Sie können festlegen, ob Sie mit einem analogen oder digitalen
Signal in die Eingänge gehen oder Sie können aus den Eingängen 1 und 2 eine Monosumme
bilden.

Link/Linkmanager
Links sind Verknüpfungen gleicher Funktionsblöcke, die über den Linkmanager auch
zwischen mehreren Controllern, verwaltet werden. Der Eintrag Link im Gerätefenster gibt
nur einen Überblick über Verknüpfungen. Siehe Kapitel Linkmanager auf Seite 40.

Memory
Bezieht sich auf den Speicher, der im Controller installiert ist. Siehe Kapitel
Speicherverwaltung des Controllers (Memory Organization) auf Seite 26.
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Offline
Im Anmeldefenster haben Sie die Möglichkeit virtuelle Controller, so genannte Offline
Devices, zu erstellen. An diesen Controllern können Sie Einstellungen vornehmen, um sie
später an reale Controller zu übertragen. Siehe Kapitel Arbeiten mit virtuellen Controllern
(Offline Devices) auf Seite 44.

Online
Werden von der CD 44 Remote Software reale, am PC angeschlossene Controller erkannt, so
werden diese als Online Devices bezeichnet.

Szenario
Szenarien beinhalten die Setups und Einstellungen der grafischen EQs aller geöffneten
Controller und alle eingerichteten Links, sowie Position und Größe der einzelnen Fenster der
Softwareoberfläche. Szenarien können abgespeichert und geladen werden. Siehe Kapitel
Szenarien auf Seite 42.

Setup
Setups sind die im Controller oder im PC gespeicherten individuellen Einstellungen der
einzelnen Routings, Filter, Limiter, Delays etc. Ein [Current Setup] ist das im Controller aktive
Setup.

Im Controller sind verschiedene Beispiel Setups gespeichert, die so genannten "Examples".

Die Einstellungen der graphischen Equalizer gehören nicht zum Setup, diese können separat
gespeichert werden.

Siehe Kapitel Aktuelle Setups laden und speichern (Current Setup) auf Seite 23.

Routing
Die Routings bestimmen, wie ein oder mehrere Eingangssignale zu den Ausgängen
geschaltet werden und welchen Weg diese Signale nehmen. Ausführliche Beschreibungen
von Beispielen, mit den dazugehörigen Schaltungen und Anschlussdiagrammen, finden Sie im
Hardwarehandbuch.

Software
Die Software, die Sie auf dem PC installieren, wird in diesem Handbuch als „Software“ oder
„Remote-Software“ bezeichnet.

Speakers
Speakers entsprechen den LSBlocks in den Controllern. Es handelt sich dabei um
lautsprecherspezifische Parametersätze, die speziell für die verfügbaren K&F Lautsprecher
erstellt wurden. Die Speakers müssen den Controllerausgängen zugeordnet werden und den
dort anzuschließenden Laustprechern entsprechen.

2.3 Übersicht der Softwarefenster

Die wichtigsten Fenster in der Softwareoberfläche sind das „Hauptfenster“, in dem
die Software insgesamt läuft, das „Anmeldefenster“ und das „Gerätefenster“. Wenn
mehrere Controller angemeldet sind, können auch mehrere Gerätefenster geöffnet sein.
Über das Gerätefenster werden die jeweiligen Unterfenster für die Einstellungen des
jeweiligen Controllers geöffnet. In der Software wird das Hauptfenster mit 'CD Remote',
das Anmeldefenster mit 'DeviceList' gekennzeichnet. Die Gerätefenster tragen jeweils den
Namen des Controllers im oberen Rahmen.
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Hauptfenster:

Anmeldefenster:

Gerätefenster:

3. Lieferumfang

Die jeweils aktuelle Remote-Software zur Steuerung des Controllers liegt als
Installationspaket zum Download auf der Website von Kling & Freitag (www.kling-
freitag.de). Neben der Remote-Software enthält dieses Paket auch die Bedienungsanleitung
als PDF-Datei, eine Software zum Updaten der Firmware (Flashloader) inklusive aktueller
Firmware sowie die Datensätze für die aktuellen K&F-Lautsprecher (Speakers / LSBlocks).
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4. Produktbeschreibung

Mit der Software können Sie alle Einstellungen am CD 44 vornehmen und ihn verwalten, z.B.:

Setups auf Festplatte verwalten und auf / vom Controller laden
Sie können die aktuellen Einstellungen aus dem Speicher (from Memory) des Controllers
laden und bearbeiten und sie auf Ihrem PC speichern (to File) und / oder im Controller (to
Memory) speichern.

Szenarien erstellen und speichern
Sie können sämtliche Einstellungen aller geöffneten Controller, einschließlich der Setups,
Verknüpfungen und der Einstellungen der grafischen EQs, auf dem PC als Scenario
abspeichern.

Mehrere Controller verknüpfen (Master - Slave)
Sie können mit der Software mehrere Controller verknüpfen. So können Sie die Einstellungen
für mehrere Controller gleichzeitig vornehmen.

Backup
Sie können mit der Funktion [Complete] eine Sicherungskopie aller Einstellungen erstellen.

Einstellungen

• Passwortverwaltung

• Betriebszustände

Eine Beschreibung der einzelnen Einstellungen finden Sie in den entsprechenden Abschnitten
der Hardwareanleitung.

5. Voraussetzungen

5.1 Persönliche Kenntnisse

Um den Controller mit der Remote-Software bedienen zu können, sollten Sie über
grundlegende Kenntnisse im Umgang mit Microsoft Windows verfügen und mit
der Bedienung des CD 44 Controllers vertraut sein. Siehe dazu die entsprechenden
Bedienungsanleitungen.

5.2 Systemvoraussetzungen

Hardware:

CD 44: PC mit Ethernet 10/100Base-TX Netzwerkanschluss, Firmwareversion 3.46 oder höher.

Software:

Die Software wurde unter Microsoft Windows XP und Windows 7 getestet.

Andere Betriebssysteme als Microsoft Windows werden nicht unterstützt!

Sie können die jeweils aktuelle Remote-Software im Downloadbereich der Website von Kling
& Freitag herunterladen (www.kling-freitag.de).

Ab der Softwareversion größer als V1.2.876 kann nicht mehr auf den CD 24-Controller
zugegriffen werden. Sollten Sie diese Programmversion benötigen, steht diese auf unserer
Intersetseite als Download zur Verfügung. Für den Zugriff auf einen CD 44 Controller sollten
Sie die aktuelle Version der CD 44 Remote benutzen.

5.3 Voraussetzungen für den CD 44

Verbinden Sie den Controller mit der Netzspannung und ermitteln Sie die Revisionsnummer
im Controller. Rufen Sie dazu am Controller die folgenden Menüs auf:

1. Klicken Sie auf Util » Info, FWRev oder auf SWRev.
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Wir empfehlen grundsätzlich die neueste Firmware zu verwenden, um den bestmöglichen
Betrieb zu gewähren. Aktuelle Programmversionen finden Sie auf www.kling-freitag.de
Bei einer Firmware-Revisionsnummer kleiner als 3.4 müssen Sie außerdem die im Controller
eingebaute IP-Karte tauschen. Dazu gehen Sie bitte vor wie in Kapitel „IP-Karte tauschen
und Firmwareupdate" auf Seite 51 beschrieben. Bei älteren Controllern erscheint im
Display des Controllers nicht FWRev, sondern SWRev.

Eine aktuelle IP-Karte kann im Austausch gegen die alte Karte bei Kling&Freitag angefordert
werden.

6. Herstellen einer Verbindung mit dem Computer

6.1 Verbindung mit dem CD 44

Um den CD 44 an Ihren Computer anzuschließen, müssen Sie ein Ethernet-Netzwerk-Kabel
und einen Switch verwenden.

Alternativ können Sie den CD 44 direkt (ohne Switch) an Ihren Computer anschließen. In
diesem Fall benötigen Sie ein gekreuztes Ethernetkabel oder einen Cross-over-Adapter.

Einige Netzwerkkarten erkennen die Sende- und Empfangsleitungen des angeschlossenen
Controllers selbständig und stellen sich darauf ein. Diese Funktion wird als Auto-MDI(X)
bezeichnet. Hierbei spielt die Verwendung des Kabeltyps (gekreuzt oder ungekreuzt) keine
Rolle. Ob Ihre Netzwerkkarte über Auto-MDI(X) verfügt, ist in der Dokumentation Ihrer
Netzwerkkarte beschrieben.

7. Installation

Zur Installation der CD Remote Software benötigen Sie entweder die dem Gerät beiliegende
Installations-CD oder die Installationsdatei "CD Remote Installer.exe", die Sie von unserer
Internetseite herunterladen können. Mit dieser Software installieren Sie auf Ihrem Computer
eine Basis-Software, mit der Sie eine aktuelle Programmversion installieren oder eine schon
installierte Version reparieren oder auch deinstallieren können.
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Aktuelle Updateinhalte der Software und der Lautsprecherblöcke werden während der
Installation über die notwendige Internetverbindung geladen. Sie benötigen daher eine
Internetverbindung und zusätzlich Administratorrechte auf Ihrem Computer.

7.1 Offline-Installer

Zuzätzlich zu diesen sonst auch üblichen Installationsoptionen haben wir für Sie die
Möglichkeit geschaffen einen "Offline-Installer" zu generieren. Der "Offline-Installer"
ist eine Datei- und Ordnerstruktur mit vollständig aktualisierten Softwareinhalten
und LS-Blöcken, mit dessen Hilfe Sie für eine vollständige Softwareinstallation keinen
Internetzugang benötigen.

Dennoch muss die Software des entsprechenden Computers von Zeit zu Zeit aktualisiert
werden. Dafür können Sie wie gewohnt eine Internetverbindung oder auch wieder einen
Offline-Installer benutzen. Wir empfehlen, dass Sie kurz vorher wieder einen aktuellen
"Offline-Installer" generieren, der bei seiner Erstellung über das Internet aktualisiert
werden würde und mit dem Sie dann die CD-Remote-Software des betroffenen Computers
aktualisieren können.

7.2 Vorgehensweise

Beim ersten Start der Software können Sie die Installationssprache bestimmen und zwischen
zwei Vorgehensweisen wählen:

• Installation

• Offline Installer erstellen

7.3 Online- und Offlineinstallation der Software

1. Nutzen Sie die beiliegende Installations CD oder laden Sie die Installationsdatei aus dem
Downloadbereich unserer Website herunter (www.kling-freitag.de).

2. Kopieren Sie die Datei CD Remote Installer Vx-xx.zip auf Ihren PC.

3. Entpacken Sie die Datei.
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4. Starten Sie die Installation mit einem Doppelklick auf die Datei CD 44 Remote Installer
VX-XX.exe.

Beachten Sie bitte, dass Sie für beide Möglichkeiten einen Internetzugang benötigen, damit
die Update-Inhalte in die jeweilige Installation eingefügt werden können.

Sie haben nun die Möglichkeit zwischen der sofortigen Installation auf dem aktuellen
Computer oder einer der Erstellung der Offline-Dateistruktur zu wählen.

Möchten Sie die Offline-Instalationsdateien erstellen, fahren Sie mit den Anweisungen unter
'Offlineinstallationsdateien erstellen' fort.

7.3.1 Software auf dem aktuellen Rechner installieren

Um die Installation auf dem aktuellen Computer durchzuführen, folgen Sie bitte diesen
Anweisungen:

1. Wählen Sie die Option 'Installation'

2. Wählen Sie die von Ihnen gewünschte Sprache aus.

3. Bestätigen Sie Ihre Auswahlen mit 'Weiter'.

4. Folgen Sie den Installationsanweisungen am PC-Bildschirm.

5. Warten Sie, bis alle Updateinhalte dem Offline-Installer hinzugefügt wurden.

Sie können nun die Software benutzen.

7.3.2 Offlineinstallationsdateien erstellen

Um die Offline-Installationsdateien zu erstellen, folgen Sie bitte diesen Anweisungen:

1. Wählen Sie die Option 'Offline Installer erstellen'.

2. Wählen Sie die von Ihnen gewünschte Sprache aus.

3. Bestätigen Sie Ihre Auswahlen mit 'Weiter'.

4. Folgen Sie den Installationsanweisungen am PC-Bildschirm.

5. Warten Sie, bis alle Updateinhalte dem Offline-Installer hinzugefügt wurden.

Sie haben nun eine Programm- und Ordnerstruktur erstellt, um diese Programmversion
über einen Datenträger auf einen anderen Computer ohne Internetanschluss installieren zu
können.

Es ist für die fehlerfreie Ausführung des Installationsprogramms unbedingt notwendig, dass
die Datei- und Ordnerstruktur unverändert bleibt.

1. Kopieren Sie bitte die komplette und unveränderte Ordnerstruktur auf eine CD oder auf
einen USB-Stick.

2. Legen Sie den Datenträger in das CD-Laufwerk Ihres Computers oder stecken Sie den
USB-Stick in einen freien USB-Steckplatz des Computers, auf den Sie die Software
aufspielen wollen.

3. Starten Sie auf dem Computer die Datei 'CD Remote Installer.exe".

Da alle notwendigen Dateien und Updateinhalte in dieser Installation hinterlegt sind, können
Sie nun eine aktuelle Programmversion mit zum Zeitpunkt der Erstellung aktuellen LS-
Blöcken ohne Internetverbindung installieren.
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Beachten Sie bitte, dass Sie die Software und die Lautsprecherblöcke auf allen Ihren Geräten
von Zeit zu Zeit aktualisieren sollten. Der aktuelle Offline-Installer ist selbstverständlich nur
mit den Inhalten aktualisiert, die zum Zeitpunkt seiner Erstellung gültig waren. Inhalte,
die später von K&F aktualisiert wurden sind verständlicher Weise nicht in dem von Ihnen
erstelltem Installationspaket enthalten.

Möchten Sie die Software zu einem viel späteren Zeitpunkt durchführen, empfehlen wir,
kurz vor einem Offline-Update ein neues Installationspaket zu erstellen um auch aktualisierte
Updateinhalte zu installieren.

7.4 Einrichten der IP-Adressen

Die folgenden Einstellungen sind nur für den CD 44 Controller gültig!

7.4.1 IP-Adressen für den PC einstellen

1. Klicken Sie auf dem Windows Desktop auf [Start] » [Einstellungen] » [Systemsteuerung]
» [Netzwerkverbindungen] » [LAN-Verbindung] (Doppelklick) » [Eigenschaften]
» [Internetprotokoll (TCP/IP)] » [Eigenschaften] » [Folgende IP-Adresse verwenden]

2. Stellen Sie eine feste IP-Adresse ein (z.B. 192.168.0.100).

Die ersten drei Ziffernblöcke der IP-Adressen vom Computer und Controller müssen
identisch sein, der letzte Ziffernblock muss unterschiedlich sein, zwischen 1 und 254. Falls
Sie mehrere Controller anschließen, muss der jeweils letzte Ziffernblock unterschiedlich
sein, da sonst Kommunikationskonflikte enstehen. Die Subnetzmaske 255.255.255.0
sollten Sie nicht verändern, sofern Sie keinen besonderen Grund hierfür haben.

Die bei Auslieferung der Controller eingestellte IP-Adresse ist 192.168.0.15.

192.168.xxx.xxx ist für private Netzwerke reserviert und daher zu empfehlen.

3. Klicken Sie zwei Mal auf Okay, um die Änderungen zu übernehmen.

Falls Ihr System dynamische IP-Adressen erfordert, tragen Sie unter 'Alternative
Konfiguration' die gewünschte Adresse für den Controller unter Benutzerdefiniert ein.
Damit können Sie eine feste IP-Adresse in einem Umfeld mit dynamischen IP-Adressen
verwenden. Der Controller selbst benötigt auf jeden Fall eine feste IP-Adresse.
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7.4.2 IP-Adresse am CD 44 einstellen

Alternativ zu dem oben beschriebenen Vorgehen können Sie die IP-Adresse des Controllers
an die vorgegebene Adresse Ihres Computers anpassen. Passen Sie in diesem Fall die ersten
drei Blöcke der IP-Adresse an.

1. Klicken Sie auf Util » IP-Address.

Tipp

Die Änderung der IP-Adresse wird erst nach Neustart des Controllers wirksam!

8. Passwörter und Zugriffsrechte

Der Controller unterscheidet drei verschiedene Berechtigungsmodi, die als Master, User und
Lock all bezeichnet werden, sowie drei jeweils zugehörige Passwörter.

Informationen zum Ändern der Passwörter und den verschiedenen Modi finden Sie unter
„Allgemeine Einstellungen ändern (Device)“auf Seite 25.

Administrator-Passwort: Das Administrator-Passwort ist seriennummernabhängig und lässt
sich nicht ändern. Es wird in Form eines Aufklebers mit dem Controller ausgeliefert. Es ist zum
Ändern des Master- und User-Passwortes erforderlich, und kann bei vergessenem Master-
Passwort statt diesem verwendet werden.

Master- und User-Passwort: Bei der Auslieferung des Controllers lautet das Passwort für den
Master Mode 'master', und für den User Mode 'user'. Beachten Sie bitte die Kleinschreibung.

Wir empfehlen dem Besitzer des Gerätes das User- und Master Passwort vor der Benutzung
von anderen Personen zu ändern, damit keine Einstellungen von unbefugten Personen
vorgenommen werden können, die ggf. zu Fehlfunktionen oder Beschädigungen von
Lautsprecheranlagen zur Folge haben könnten.
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Nach einem Update der Software werden die Passwörter wieder auf die Passwörter des
Auslieferungszustandes zurückgesetzt.

Die drei verschiedenen Berechtigungsmodi:

Master:
Im Master-Mode ist die Bedienung in vollem Umfang möglich. Um in diesen Modus zu
gelangen, benötigen Sie entweder das Master- oder das Administrator-Passwort.

User:
Es ist nur eine eingeschränkte Bedienung für Anwender möglich (keine Änderung von
Setups, keine Änderung von LS-Blöcken etc.). Dieser Modus bietet sich an, wenn Sie den
Controller beispielsweise verleihen und nicht möchten, dass grundlegende Änderungen oder
Einstellungen vorgenommen werden, die möglicherweise die Betriebssicherheit gefährden
könnten. Die entsprechenden Funktionen sind in der Software ausgegraut. Um in diesen
Modus zu gelangen, benötigen Sie das User-Passwort.

Lock all: Es können keinerlei Einstellungen mehr am Controller vorgenommen werden. Diese
Einstellung schützt den Controller vor unbefugtem Zugriff. Wird in der Remote-Software ein
Controller mit einem falschen oder keinem Passwort gestartet, so öffnet er sich im Lock all-
Modus.

Es wird außerdem zwischen Device-Modus und Software-Modus unterschieden.

Der Device-Modus legt die Bedienberechtigung im Controller fest, wenn er nicht über die
Remote-Software bedient wird.

Der Software-Modus legt die Berechtigung in der Remote-Software fest, unabhängig
vom Device-Modus. Der jeweilige Modus wird durch die Eingabe des Passwortes bei der
Anmeldung gewählt. Je nachdem, welches Passwort bei der Anmeldung eingegeben wird,
wird das Gerätefenster im entsprechenden Software-Modus geöffnet. Wird kein oder ein
falsches Passwort eingegeben, wird im Lock all-Modus gestartet. Siehe Kapitel Controller
in der Software aufrufen auf Seite 17. Wird der Controller abgemeldet, ist er wieder in
seinem ursprünglichen Device-Modus.

Die Passwörter für den Device-Modus und den Software-Modus sind identisch.

Ist ein Controller in der Remote-Software angemeldet, so ist die Bedienung im Gerät
blockiert.

9. Software starten und Controller anmelden

9.1 Software starten

1. Klicken Sie auf Start » Alle Programme » Kling & Freitag CD 44 Remote » CD Remote.

9.2 Controller anmelden

9.2.1 IP-Adresse des PC in der Software auswählen

Nur CD 44!



Benutzerhandbuch K&F CD 44 Remote

KLING & FREITAG GMBH © 2014 Version 5.5 Seite 17 von 56

Sie müssen die IP-Adresse direkt in der Remote-Software auswählen. Falls mehrere
Netzanschlüsse mit eigenen IP-Adressen vorhanden sind (z.B. mehrere Netzwerkkarten),
müssen Sie die Karte auswählen, die Sie verwenden möchten.

1. Klicken Sie auf Edit » Connection Settings.

2. Im Bereich IP Settings: Aktivieren Sie das Kontrollkästchen Enabled.

3. Die IP-Adresse Ihres PC wird angezeigt. Sind mehrere IP-Adressen vergeben oder mehrere
Netzwerkkarten installiert, wählen Sie die entsprechende IP-Adresse aus.

4. Sollte ihr Netzwerk den Controller nicht erkennen, so kann es sein, dass es nicht genug
Zeit hat alle Netzwerkadressen zu scannen. In diesem Fall erhöhen Sie bitte die Zeit für
das Network Polling (Ein zu hoher Wert verlangsamt das Auffinden ihrer Controller). Der
maximale Wert beträgt 200 ms.

9.3 Controller in der Software aufrufen

Wenn die Software gestartet wurde, sucht sie automatisch nach Controllern im Netz.
Angeschlossene CD 44 werden allerdings nur erkannt, wenn die ersten drei Blöcke der IP-
Adressen identisch sind und der letzte Block bei allen Controllern einen unterschiedlichen
Wert hat.

Nach einigen Sekunden sollten alle angeschlossenen Controller angezeigt werden.

1. Klicken Sie in der Spalte 'Password' auf  .

Geben Sie das Passwort des Berechtigungsmodus ein, unter dem Sie sich anmelden
wollen. Wird ein ungültiges oder kein Passwort eingegeben, so startet die Software im
Lock all Modus.
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Der PC speichert das jeweils zuletzt verwendete Passwort und verwendet es beim
nächsten Einloggversuch wieder.

Um das Passwort aus der Eingabemaske zu löschen, gehen Sie wie folgt vor:

2. Klicken Sie im Hauptfenster auf Edit » Clear Stored Passwords.

Im Auslieferungszustand ist der Name des Controllers „Unit 1“. Wenn Sie mit mehreren
Controllern online arbeiten wollen, müssen Sie den Controllern unterschiedliche Namen
geben. Siehe Kapitel Controllernamen ändern (Name) auf Seite 25.

3. Aktivieren Sie das Kontrollkästchen Online.

Das Gerätefenster wird geöffnet, und der Controller ist online.

Im Display des Controllers wird seine IP-Adresse und „Remote-controlled“ angezeigt. Am
Controller selbst ist jetzt keine manuelle Bedienung mehr möglich.

Tipp

Geräte mit Speichererweiterung sind in der Online- und Offliniespalte grau hinterlegt.

10. Menüs im Haupt- und Anmeldefenster

10.1 Kurzbeschreibung der Menüs im Hauptfenster

Name Untermenü Funktion

Connection Settings VerbindungseinstellungenEdit

Clear Stored Passwords Alle im PC gespeicherten
Passwörter löschen

Load from File Szenario vom PC ladenSzenario

Save to File Scenario auf PC speichern
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Linkmanager Funktionsblöcke einzelner
und verschiedener
Controller miteinander
verknüpfen.
Siehe Kapitel
Linkmanager,
Verknüpfungen von
Funktionsblöcken auf
Seite 40.

Options Global Settings Globale Einstellungen für
das Anti-Air-Loss Filter
und für die Aktivierung
und den Speicherort der
Complete Defaults für
Offline Devices.

Info Versionsinformation zur
Software

Name Funktion

DeviceList Anmeldefenster wird in den Vordergrund
gebracht

Unit 1, Unit 2, [Gerätename] Gerätefenster des jeweiligen Controllers
wird in den Vordergrund gebracht

10.1.1 Globale Einstellungen

Hier können Sie allgemeine Einstellungen vornehmen: Klicken Sie auf Options » Global
Settings.

Einstellung Funktion
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Device window Um Platz aud dem Bildschirm zu sparen,
deaktivieren Sie das Kontrollkästchen.
Im Gerätefenster werden dadurch die
Kanalnamen ausgeblendet.

Delay/Units Eingabe der Delays in Metern oder
Millisekunden

velocity Schallgeschwindigkeit

air attributes H: Relative Luftfeuchtigkeit
T: Lufttemperatur

Offline Devices Aktivieren Sie das Kontrollkästchen, wenn
Offline Devices (virtuelle Geräte) mit
kompletten voreingestellten Daten und
Einstellungen versehen werden sollen.
Geben Sie im Auswahlmenü an, welche
Einstellungsdatei nach Erstellung eines
virtuellen Controllers geladen werden
soll.

Standardmäßig ist das Kontrollkästchen
aktiviert und die im Auslieferungszustand
mitgelieferte CDX4 Complete Defaults
VX-XX.dcc wird geladen.

Eigene Complete Defaults erstellen Sie
wie folgt: Klicken Sie im Gerätefenster
auf Memory Organization » Complete »
SaveToFile.

Siehe auch Kapitel Arbeiten mit virtuellen
Controllern (Offline Devices) auf Seite
44.

10.2 Menüs des Anmeldefensters (DeviceList)

Name Funktion

Name Name des CD 44

Interface IP-Adresse des CD 44

Password Passwort (assigned weist darauf hin, dass
ein Passwort für den Controller auf dem
PC gespeichert wurde)

Status Found: Controller erkannt

Loaded: Controller angemeldet und Setup
geladen

Closed: Controller wurde abgemeldet.
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Online 2) Dieses Kontrollkästchen ist nur für
Controller verfügbar, die mit dem
Computer verbunden sind.
Wenn dieses Kontrollkästchen aktiviert
wird, öffnet sich das Gerätefenster und
der Controller kann über die Software
bedient werden. Er ist für andere Nutzer
im Netz nicht mehr sichtbar.

Offline 2) Dieses Kontrollkästchen ist nur für
virtuelle Controller verfügbar.
Wenn dieses Kontrollkästchen aktiviert
wird, öffnet sich das Gerätefenster und
der virtuelle Controller kann über die
Software bedient werden.

Siehe auch Kapitel Arbeiten mit virtuellen
Controllern (Offline Devices) auf Seite
44.

FWRev Version der Firmware

HWRev Version der Hardware (Platinen)

SN Seriennummer des Controllers

2) Geräte mit Speichererweiterung sind in der Online- und Offliniespalte grau hinterlegt.

11. Geräteeinstellungen ändern / speichern

Geänderte Einstellungen werden in Intervallen von ca. fünf Sekunden auf den Controller
gespeichert, um die Arbeit an den Einstellungen z.B. durch Stromausfall zu sichern. Auch
wenn Sie den Controller ausschalten, bleiben diese Einstellungen aktiv. Lediglich die
Änderungen, die an Setups vorgenommen werden, werden nicht automatisch gespeichert.
Diese müssen nach Beendigung der Einstellungen manuell gespeichert werden. Siehe auch
Kapitel Aktuelle Setups laden und speichern (Current Setup) auf Seite 23.

11.1 Generelles Vorgehen zur Systemeinrichtung

Wenn Sie eine Anlagenkonfiguration einrichten wollen, beginnen Sie damit die verkabelte
Hardware in der Software abzubilden und stellen Sie dann die Details ein.

Gehen Sie wie folgt vor:

1. Wählen Sie das gewünschte Routing aus.

2. Wählen Sie das gewünschte Input-Patching aus.

3. Wählen Sie die angeschlossenen Lautsprecher aus.

4. Vergeben Sie einen Namen für den Signalausgang.

5. Stellen Sie die individuellen Filter, Limiter etc. ein.

6. Erstellen Sie gewünschte Master-Bedienelemente.

7. Für Einrichtungen mit mehreren Controllern können Sie die gesamte Konfiguration als
Szenario speichern.

Eine genauere Beschreibung der Anlagenkonfigurationen finden Sie im Hardware Manual.

Um einen Namen für einen Signalausgang zu vergeben, doppelklicken Sie auf den
voreingestellten Namen oberhalb der Symbolleiste oder klicken Sie auf das Symbol [Output].

Menüs im Gerätefenster
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11.1.1 Kurzbeschreibung der Menüs im Gerätefenster

Name Untermenü Funktion

Aktive Setups vom / auf
PC / Controller laden /
speichern

Load from Memory Setup vom Controller
laden

Load from File Setup vom PC laden

Save to Memory Setup auf Controller
speichern

Current Setup

Save to File Setup auf PC speichern

Laden oder Speichern,
ohne dass die Setups
im Controller geändert
werden. (Beim Complete-
Backup werden auch
die aktuellen Setups
überschrieben)

Setups Setups verwalten

EQ-Sets Equalizer-Einstellungen
verwalten

Speakers Lautsprecherblöcke
(LSBlocks) verwalten

Names Funktion für Anwender
nicht verfügbar

PrefilterRest Funktion für Anwender
nicht verfügbar

Memory Organization

Complete Laden oder Speichern
einer Sicherungskopie
aller Controllerdaten
(Complete-Backup)

Allgemeine Einstellungen
verwalten

Name Gerätenamen ändern

Passwords Passwörter ändern

Device

DeviceMode Zugriffsrecht /
Berechtigungsmodus
ändern

Detaillierte Beschreibungen der Untermenüs finden Sie in den folgenden Abschnitten.

11.2 Aktuelle Setups laden und speichern (Current Setup)
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Im Menü 'Current Setup' laden Sie die Setups aus dem Speicher des Controllers oder vom PC
in den Arbeitsspeicher des Controllers.

Im Auslieferungszustand hat der CD 44 vierzehn (Example 1 - 14) Beispielsetups. Die
entsprechenden Einstellungen können Sie ändern und als neue Setups unter einem anderen
Namen abspeichern.

Insgesamt können bis zu 64 Setups im Controller gespeichert werden. Die Dateierweiterung
'.dsc' wird automatisch vergeben, wenn Sie ein Setup auf dem PC speichern.

Wenn Sie Änderungen an dem 'Current Setup' vornehmen, wird unter 'Setup Loaded:
[Setupname]' ein Sternchen (*) angezeigt.

Dies gilt auch für gleichnamige Setups! Wird ein Setup mit Current Setup » LoadFromFile aus
einer Datei oder einem Szenario geladen, so wird das aktuelle Setup überschrieben.

Load From Memory

Aufrufen von Setups, die im Controller gespeichert sind: Klicken Sie im Gerätefenster auf
Load From Memory » Dateiauswahl » OK.

Load From File

Aufrufen von Setups, die im PC gespeichert sind: Mit [Load From File] » [Öffnen] können
Sie die Setups aufrufen, die im Computer gespeichert wurden. Klicken Sie im Gerätefenster
auf Load From File » Dateiauswahl » Öffnen. Die Dateien sind im .dsc-Format abgespeichert
(Example 1.dsc usw.). Soll das Setup auch nach dem Ausschalten des Controllers noch zur
Verfügung stehen, so muss das geladene Setup mit Save To Memory abgespeichert werden.

Save To Memory

Das aktuell eingerichtete Setup im Controller speichern: Klicken Sie im Gerätefenster auf Save
To Memory » Namensauswahl oder auf new » OK.

Save to File

Das aktuell eingerichtete Setup auf dem PC speichern: Klicken Sie im Gerätefenster auf Save
to File » Pfadauswahl und auf Namensauswahl » Speichern.
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Tipp

Der Name des Setups behält seinen ursprünglichen Namen, unabhängig, wie Sie die
gespeicherte Datei genannt haben. Wollen Sie dem Setup auch im Gerätefenster einen
neuen Namen geben (Setup Loaded:), so müssen Sie das Setup zuerst im Gerät speichern.

Klicken Sie im Gerätefenster auf Save To Memory » Namensauswahl oder auf new » OK.

11.3 Allgemeine Einstellungen ändern (Device)

In diesem Menü können Sie Gerätenamen, Passwörter und Zugriffsrechte ändern.

11.3.1 Controllernamen ändern (Name)

Wenn Sie mehrere Controller im Netz verwenden, ist es unbedingt notwendig, dass die
Controller unterschiedliche Namen haben. Sonst können die Controller im Netz nicht
angesprochen werden. Sie können den Namen frei wählen.

Sie können den Namen wie folgt ändern:

1. Öffnen Sie das Gerätefenster.

2. Klicken Sie auf Device » Name.

3. Geben Sie den neuen Namen ein.

4. Klicken Sie auf OK.

11.3.2 Passwörter ändern (Passwords)

Sie können die Passwörter wie folgt ändern:

1. Öffnen Sie das Gerätefenster.

2. Klicken Sie im Gerätefenster auf Device » Passwords.

3. Geben Sie das Administrator-Passwort ein.

4. Wählen Sie das Passwort aus, das Sie ändern möchten.

5. Geben Sie das neue Passwort ein.

11.3.3 Benutzergruppe ändern (Device Mode)



Benutzerhandbuch K&F CD 44 Remote

KLING & FREITAG GMBH © 2014 Version 5.5 Seite 26 von 56

Mit dieser Funktion können Sie den Berechtigungsmodus des Controllers einstellen der gültig
ist, wenn er nicht über die Software gesteuert wird. Der aktuelle Modus wird im mittleren
Bereich des Gerätefensters unter 'Mode:' angezeigt.

Sie können den Modus wie folgt einstellen:

1. Klicken Sie im Gerätefenster auf Device » DeviceMode. Wählen Sie den gewünschten
Modus aus.

Ist der gewählte Modus niedriger als der ursprüngliche (z.B. von Master auf User), so wird
kein Passwort abgefragt. Ist der gewählte Modus höher als der ursprüngliche (z.B. von
Lock All auf User), so wird das Passwort des neu ausgewählten Modus abgefragt.

2. Geben Sie das entsprechende Passwort ein.

11.3.4 Info Fenster (Info)

Neben den üblichen Hard- und Sofwareinformationen werden auch die im Servicefall
benötigten Informationen angezeigt.

11.4 Speicherverwaltung des Controllers (Memory Organization)

Sie können Daten aus dem Controller auf der Festplatte des PCs speichern, Daten vom PC
in den Speicher des Controllers übertragen und Daten auf dem Controller löschen. Diese
Funktionen sind z.B. sinnvoll, wenn Sie Datensätze von einem Controller auf ein anderen
übertragen wollen oder nicht genutzte LS-Blöcke aus dem Controller entfernen wollen, um
das Auswahlmenü für die Lautsprecher übersichtlicher zu machen.

Tipp

Wenn man mit der Maus unter Memory Organization über die Felder Setups, EQ-Sets oder
Speakers geht, so erscheint eine Kurzinformation, wieviel Speicher belegt und insgesamt
vorhanden ist.

11.4.1 Setups verwalten

Unter Memory Organization » Setups im Gerätefenster können Sie die Setups im Controller
verwalten.
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1. Add

Mit Add können Sie Setups vom PC in den Speicher des Controllers laden. Es öffnet sich
ein Dateiauswahl-Fenster in dem Sie die gewünschte Datei mit der Dateiendung *.dsc
auswählen. Anschließend steht Ihnen dieses Setup unter Current Setup » Load From
Memory zur Verfügung, um es als aktives Setup (Current Setup) verwenden zu können.

2. SaveToFile

Mit SaveToFile können Sie im Controller vorhandene Setups auf den PC speichern. Eine
Mehrfachauswahl ist möglich. Es öffnet sich ein Dateiauswahl-Fenster in dem Sie den
Pfad und den Namen zum Speichern auswählen.

3. Delete

Mit Delete können Sie im Controller vorhandene Setups löschen. Eine Mehrfachauswahl
ist möglich.

Der voreingestellte Dateipfad für die Setups ist:
Eigene Dateien, bzw. gemeinsame Dateien\Kling & Freitag\CD Remote\CDX4 Setups\*.dsc

11.4.2 Equalizer-Presets verwalten (EQ-Sets)

Nur CD 44!

Unter Memory Organization » EQ-Sets im Gerätefenster verwalten Sie vorhandene EQ-
Einstellungen des 31-Terzband-EQs.

1. Add

Mit Add können Sie EQ-Sets vom PC in den Speicher des Controllers laden. Es öffnet sich
ein Dateiauswahl-Fenster in dem Sie die gewünschte Datei mit der Dateiendung *.dec
auswählen. Anschließend steht Ihnen das EQ-Set im Controller zur Verfügung. Um das
EQ-Set zu verwenden, doppelklicken Sie auf das folgende Symbol des entsprechenden
Kanals:

Wenn Sie dann die Schaltfläche Load drücken, öffnet sich ein Dateiauswahl-Fenster in
dem Sie das gewünschte EQ-Set (*.dec) auswählen können.

2. SaveToFile



Benutzerhandbuch K&F CD 44 Remote

KLING & FREITAG GMBH © 2014 Version 5.5 Seite 28 von 56

Mit SaveToFile können Sie im Controller vorhandene EQ-Sets auf den PC speichern. Eine
Mehrfachauswahl ist möglich. Es öffnet sich ein Dateiauswahl-Fenster in dem Sie den
Pfad und den Namen zum Speichern auswählen.

3. Delete

Mit Delete können Sie im Controller vorhandene EQ-Sets löschen. Eine Mehrfachauswahl
ist möglich.

11.4.3 Speakers (LSBlocks) verwalten

Unter Speakers » LSBlöcke im Gerätefenster können Sie entweder 64 LSBlocks (ohne
Speichererweiterung) oder 192 LSBlocks (CD 44 mit Speichererweiterung) verwalten.

Sie können den Controller und die Software nur für Kling & Freitag-Lautsprecher verwenden.
Die notwendigen Parameter wie Limiter und Filter etc. sind für die jeweiligen Lautsprecher
voreingestellt. Die spezifischen Einstellungen für die jeweiligen Lautsprecher können nicht
geändert werden.

1. Add

Mit Add können Sie Speakers vom PC in den Speicher des Controllers laden. Es öffnet
sich ein Dateiauswahl-Fenster in dem Sie die gewünschte Datei mit der Dateiendung
*.dbc auswählen. Anschließend steht Ihnen der Speaker im Controller zur Verfügung.
Um den Speaker im Controller zu verwenden, drücken Sie auf das folgende Symbol des
entsprechenden Kanals:

Es öffnet sich ein Auswahlfenster in dem Sie den gewünschten Speaker auswählen
können.

2. SaveToFile

Mit SaveToFile können Sie im Controller vorhandene Speakers (LSBlocks) auf den PC
speichern. Eine Mehrfachauswahl ist möglich. Es öffnet sich ein Dateiauswahl-Fenster in
dem Sie den Pfad und den Namen zum Speichern auswählen.

3. Delete

Mit Delete können Sie im Controller vorhandene Speakers (LSBlocks) löschen. Eine
Mehrfachauswahl ist möglich.

Wird der Speaker (LSBlock) in Setups verwendet, zeigt sich ein Warnhinweis, den Sie mit
[OK] bestätigen müssen.

In diesem Fall müssen Sie erst die Setups löschen, in denen der Speaker (LSBlock)
verwendet wird. Anschließend wiederholen Sie den Vorgang und bestätigen das Löschen,
bzw. brechen den Vorgang ab.

Sie können die jeweils aktuellen Speakers (LSBlocks) im Downloadbereich der Website der
Kling&Freitag GmbH herunterladen (www.kling-freitag.de)
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Der voreingestellte Dateipfad für die Speakers (LSBlocks) ist:

Eigene Dateien, bzw. gemeinsame Dateien\Kling & Freitag\CD Remote\LS-Blocks\

Legen Sie die (entpackten) Dateien mit den Speakers (LSBlocks) in den voreingestellten
Dateipfad, um sie verwenden zu können.

11.4.4 Complete-Backup

Mit dieser Funktion können Sie ein Backup aller Daten und Einstellungen des Controllers
anlegen (Setups + EQ-Sets, Lautsprecher-Sets (LSBlocks), IP-Adressen, Displayeinstellungen
etc.).

1. SaveToFile

Sie können die Einstellungen des Controllers als Datei auf dem PC speichern.

Klicken Sie auf Memory Organization » Complete » SaveToFile.

Geben Sie den gewünschten Dateinamen ein. Die Datei wird mit der Endung .dcc
abgespeichert.

Der voreingestellte Dateipfad für die Einstellungsdatei ist: Eigene Dateien, bzw.
gemeinsame Dateien\Kling & Freitag\CD Remote\

2. LoadFromFile

Klicken Sie auf Memory Organization » Complete » LoadFromFile.

Wählen Sie die Backup-Datei aus.

Beachten Sie, dass alle im Controller gespeicherten Daten überschrieben werden.

Sie werden gefragt, ob Sie die Ethernetadresse und den Namen des Controllers
beibehalten oder aus der Datei laden möchten. Ebenso haben Sie die Möglichkeit, die
aktuellen Passwörter mit denen aus der Backup-Datei zu ersetzen. Beachten Sie, dass
Sie die aktuellen Passwörter nur mit Hilfe des Administrator-Passwortes ändern können.
Wählen Sie die gewünschten Optionen.

Sie können die jeweils aktuellen CDX4 Complete Defaults VX-XX.dcc (das ist die Datei
für die die Controllereinstellungen im Auslieferungszustand) im Downloadbereich der
Website von Kling & Freitag herunterladen (www.kling-freitag.de).

Tipp

Es ist möglich ein 'Complete Backup' eines Gerätes ohne Speichererweiterung in eines mit
Erweiterung zu laden. Dabei werden die nicht benötigten Speicherplätze mit Platzhaltern
überschrieben. Umgekehrt ist dies aber nicht möglich.

Tipp

Hinweis für SEQUENZA 10 N/W Nutzer:

Gilt nur für ein Update von einer Softwareversion kleiner 1.3 auf Version 1.3 oder höher!

Nach dem Laden eines 'Complete-Backups' befinden sich SEQUENZA 10 N/W Speakers
(LSBlocks) im Controller, die nicht über den vollen Bedienkomfort verfügen. Dieser bietet die
Möglichkeit SEQ LShelv Filter über die Anzahl der verwendeten Lautsprecher automatisch
einzustellen. Siehe Kapitel Parametrische Filter auf Seite 36.

Um dieses Feature zu bekommen, haben Sie die Möglichkeit die entsprechenden
Lautsprecher-Setup zu aktualisieren.

Eine Aktualisierung der Lautsprecher-Setups zur Erweiterung des Bedienkomforts ist
notwendig, wenn die Revisionsnummer der 'SEQ Speakers' kleiner al 1.4 ist.

Sie finden die Revisionsnummer ihrer Lautsprecher im Gerätefenster in der Spalte [Rev].
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Ohne eine Aktualisierung der 'Sequenza Speakers', müssen Sie die SEQ LShelv-Filter für
SEQUENZA 10 N/W Lautsprecher manuell einstellen. Siehe dazu die entsprechende Tabelle im
Kapitel [Parametrische Filter 'PEQ' + SEQ LShelv (Filter A Taste)] des Hardware Manuals für
den Controller.
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12. Input-Patching (Konfiguration der Eingänge)

Nur CD 44!
Mit dem Input-Patching können Sie die physikalischen Eingänge konfigurieren. So können Sie
z.B. physikalisch vertauschte Eingänge im Controller zurück tauschen ohne die eigentlichen
Stecker ändern zu müssen. Sie können festlegen, ob Sie mit einem analogen oder digitalen
Signal in die Eingänge gehen oder Sie können aus den Eingängen 1 und 2 eine Monosumme
bilden.

12.1 Verfügbare Input-Patchings

Standardmäßig stehen die folgenden Patchings zur Verfügung.

Input-Patching Funktion

Analog.default Standard, analog

Analog.Flipped 1 und 2 bzw. 3 und 4 vertauscht, analog

Analog.1+2 Mixed Monosumme aus 1 und 2, analog

Digital.default Standard, digital

Digital.Flipped 1 und 2 bzw. 3 und 4 vertauscht, digital

Digital.1+2 Mixed Monosumme aus 1 und 2, digital

Eine detaillierte Beschreibung der einzelnen Patchings finden Sie in der Hardwareanleitung.

12.2 Patchings auswählen

Die im Controller verfügbaren Patchings können Sie wie folgt auswählen:

1. Klicken Sie im Gerätefenster auf das aktuelle Patching (Modes: Input:).

2. Wählen Sie das gewünschte Patching aus.
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13. Routings

Die Routings bestimmen, wie ein oder mehrere Eingangssignale zu den Ausgängen
geschaltet werden und welchen Weg diese Signale nehmen. Ausführliche Beschreibungen
von Beispielen, mit den dazugehörigen Schaltungen und Anschlussdiagrammen, finden Sie im
Hardwarehandbuch.

13.1 Verfügbare Routings

Standardmäßig stehen die folgenden Routings zur Verfügung.

• 1 in 4 out

• 1 in 4 out (Linked)

• 2 in 4 out

• 2 in 4 out (Linked)

• 4 in 4 out

• 1 in 2 + 2 in 2

• 1 in 3 + AUX

• 1 in 4 in 4

• 1 in 3 + 1 in 1

• 2 in 4 in 4

• 1 in 2 + Aux + 1 in 1

• 1 in 2 in 2 + 2 in 2

13.2 Routings aufrufen

Die im Controller verfügbaren Routings können Sie wie folgt aufrufen:

1. Klicken Sie im Gerätefenster auf das aktuelle Routing.

2. Wählen Sie das gewünschte Routing aus.

Der Signalpfad des gewählten Routings wird im unteren Bereich des Gerätefensters
dargestellt.
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14. Filter, Limiter, Delays einstellen

Sie können die individuellen Einstellungen für Filter, die angeschlossenen Lautsprecher für
jeden Kanal, Delays, Limiter etc. ändern, nachdem Sie das entsprechende 'Routing' und 'Input
Patching' für die aktuelle Anlagenkonfiguration ausgewählt haben. Im unteren Teil des
Gerätefensters erscheinen dann die entsprechenden Icons.

14.1 Übersicht der Symbole

Icon Funktion (wird bei Mouseover angezeigt)

31-Terzband-EQ (Siehe EQ 31 Band in der
Hardwareanleitung) (nur CD 44)

Filter (Siehe Parametrische Filter und
Highboost-, Cluster- und Bass Boost Filter
in der Hardwareanleitung.)

Angeschlossene Lautsprecher
(Siehe 'Select LsBlock' in der
Hardwareanleitung.)

Limiter (Siehe 'LimReduction' in der
Hardwareanleitung.)

Ein- und Ausgangsgains (siehe Kapitel
Gains in der Hardwareanleitung.)

Delay (siehe Kapitel Delay in der
Hardwareanleitung.) (Das Eingangsdelay
steht nur beim CD 44 zur Verfügung.)

Outputname

Amp Gain (Siehe 'AmpGain' in der
Hardwareanleitung.)

14.2 Parameter ändern

Beachten Sie die Hinweise zu den einzelnen Einstellungen in der Hardwareanleitung. Sie
können die Einstellung wie folgt ändern:

1. Doppelklicken Sie auf das entsprechende [Icon].

2. Stellen Sie den gewünschten Wert ein.

3. Drücken Sie die 'Enter-Taste' auf der PC-Tastatur, wenn Sie Werte über die Tastatur
eingegeben haben, damit die Einstellung übernommen wird.
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Sie können alle Eingaben auch mit den Pfeiltasten oder dem Scrollrad der Maus vornehmen,
wobei Sie mit gleichzeitigem drücken von [Strg] die Schrittweite vergrößern und mit [Alt]
verkleinern können.

Die Änderungen müssen nicht gesondert auf dem Controller gespeichert werden, sondern
werden sofort auf den Controller übertragen und dort nach spätestens 5 Sekunden
gespeichert.

14.2.1 Equalizer (WYSIWYG)

14.2.1.1 Funktionsweise

Ab der Firmware-Version 5.1 gibt es einen zusätzlichen WYSIWYG Modus für die Graphic EQs.
Bei einem traditionellen 31 Band EQ beeinflusst der Wert eines Frequenzbandes auch seine
Nebenbänder. Aus diesem Grund unterscheidet sich der tatsächlich erzeugte Frequenzgang
vom eigentlich eingestellten.

Die Beeinflussung der Bänder und das daraus resultierende Ergebnis kann man im folgenden
Bild deutlich erkennen.

Mit Hilfe des WYSIWYG Modus wird nun erreicht, dass der resultierende Frequenzgang dem
eingestellten Frequenzgang entspricht.

Befindet sich der Controller im WYSIWYG-Modus wird der Soll-Frequenzgang intern
berechnet und anschließend durch die 31 Bell Filter der GEQs eingestellt. Eine Aktualisierung
der Einstellungen erfolgt nach jeder Änderung des GEQ.

Der Modus wird im EQSetting des Controllers gespeichert und kann sowohl in der Remote-
Software als auch am Gerät geändert werden. Im EQ Editier-Fenster können Sie den Modus
ein- und ausschalten.
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14.2.1.2 Setupwechsel und Filteränderungen

Bisher wurde beim Laden von Setups oder LS-Blöcken eine Mutefunktion ausgeführt. Im
Gegensatz dazu erfolgte bei Änderungen einzelner Filter eine Fadefunktion auf der Basis von
Koeffizienten.

In der neuen Firmware wurde diese Vorgehensweise geändert. Die Fadefunktion wird nicht
mehr auf Koeffizienten, sondern auf der Basis der analogen Filtereinstellungen durchgeführt.
Ein Mute ist deshalb auch beim Laden von Setups und LS-Blöcken nicht mehr nötig.

Daraus ergibt sich die Möglichkeit eines besseren A/B Vergleiches zwischen zwei
Lautsprecherblöcken. Des Weiteren können anstelle eines im LS-Block schaltbaren Filters zwei
LS-Blöcke, jeweils mit und ohne Filter, gespeichert werden. Die Schaltfunktionen erreichen Sie
dann durch das Laden der Blöcke.

14.2.2 Parametrische Filter

Eine ausführliche Beschreibung der Filter finden Sie in der Hardwareanleitung.

LShelv (Low Shelving Filter) und HShelv (High Shelving Filter)

Tipp

Höhere Güten als 0,707 sind beim LShelv und HShelv nicht sinnvoll, da sie höchstens zu
unerwünschten Klangverfärbungen führen können (siehe Grafik). Q ist in 0,001-Schritten von
0,2 bis 20 einstellbar.
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FilterType = 'LShelv' (Shelving Lowpass) Gain = +3dB  Freq = 1000Hz

Q = 0.707   (default)
Q = 10

SEQ LShelv

Die LShelv Filter für die Sequenza Topteile lassen sich in der Software mit aktuellen
SEQUENZA 10 N/W Speakers (LSBlocks) nur über die Anzahl der zu verwendenden Topteile
mit Vorgabewerten einstellen.

Dazu klicken Sie im Gerätefenster auf ein Symbol für die Filter und dann klicken Sie neben
den Eintrag 'Named Filter' auf die dort angezeigte Anzahl x SEQ. Im Aufklappmenü wählen
Sie die Anzahl der Sequenza Topteile, die Sie im entsprechenden Array verwenden werden.
Eine Feineinstellung der Werte kann vom Toningenieur am Controller vorgenommen werden,
sobald der Controller nicht mehr mit dem Computer verbunden ist.
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Tipp

Sollten Sie an dieser Stelle die Filter nicht über die Anzahl der Lautsprecher einstellen
können, so verwenden Sie keine aktuellen SEQUENZA 10 N/W Speakers (LSBlocks).

In diesem Fall haben Sie die Möglichkeit die entsprechenden Speakers (LSBlocks) zu
aktualisieren. Siehe Hinweis für SEQUENZA 10 N/W Nutzer: im Kapitel Update der CD Remote
Software auf Seite 48 f.

Ohne eine Aktualisierung der 'Sequenza Speakers', müssen Sie die SEQ LShelv-Filter für
SEQUENZA 10 N/W Lautsprecher manuell einstellen. Siehe dazu die entsprechende Tabelle im
Kapitel [Parametrische Filter 'PEQ' + SEQ LShelv (Filter A Taste)] des Hardware Manuals für
den Controller.

HighP (High Pass Filter) und LowP (Low Pass Filter)

Ein Q größer als '1' bewirkt eine Pegelanhebung der Grenzfrequenz.
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FilterType = 'HighP' (Highpass) Freq = 1000Hz

Q = 0.707  (default)  Butterworth -12dB/Oct
Q = 10

Um eine unbeabsichtigte Pegelanhebung zu verhindern, wird die Filtergüte beim Umschalten
der Filter standardmäßig auf 0,7 gesetzt. Ein Q von 0 ergibt ein Hoch- bzw. Tiefpass
1.Ordnung, d.h. 6dB/Oktave.

14.2.3 Anti Air-loss Filter

Mit diesem Filter können Sie die Hochtonverluste bei längeren Übertragungsstrecken
ausgleichen. Die Luftschalldämpfung (Dissipation) kann mittels des ersten Filters der PreEQs
in Form eines Bellfilters kompensiert werden.
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Sie können die Einstellung wie folgt ändern:

1. Klicken Sie in dem entsprechenden Filter auf das Feld neben 'Anti Air-loss'.

2. Geben Sie die gewünschte Entfernung in Metern ein.

Entsprechend der Temperatur- und Luftfeuchte-Einstellungen unter [Options] ->
[GlobalSettings] wird das Filter eingestellt und ist manuell nicht mehr zu verändern. Geben
Sie als Entfernung '0' ein, so wird das Filter mit den zuletzt errechneten Werten wieder
manuell bedienbar.

Zur Einstellung der Temperatur- und Luftfeuchtigkeit Siehe Kapitel Globale Einstellungen auf
Seite 19.

Beschreibung:

Eine Änderung der Temperatur oder Luftfeuchtigkeit im GlobalSettings-Dialog führt zu einer
unmittelbaren Aktualisierung der aktivierten Antidissipationsfilter unter Berücksichtigung
der jeweiligen Entfernungseinstellung.

Aus den gegebenen Parametern berechnet die Software ein optimal an die
Luftabsorptionskurve angepasstes Kompensationsfilter.

Der Kompensationsbereich wird filigran von der Software so beschränkt, dass keine technisch
unsinnigen Extremkorrekturen stattfinden können. So ist das Maximum der Höhenanhebung
auf 10 dB beschränkt, genauso wie die Filtermittenfrequenz auf Werte zwischen 6 kHz und
20 Khz beschränkt ist.

Ergibt sich aufgrund der berechneten Sollkurve, dass die theoretische
Kompensationsanhebung über 10dB liegt, wird die maximale Kompensationsfrequenz neu
bestimmt.

Beispiele:
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15. Linkmanager, Verknüpfungen von Funktionsblöcken

Zur einfacheren Bedienung können einzelne Funktionsblöcke verknüpft werden, die damit
in eine Master - Slave Beziehung gesetzt werden. Master wird das Bedienelement genannt,
welches die Kontrolle übernimmt, Slave werden die Bedienelemente genannt, die vom
Master gesteuert werden.

Neben dem Verknüpfen von Funktionsblöcken in einem Controller, können Funktionsblöcke
auch geräteübergreifend verknüpft werden.

Verknüpft werden können:

1. Grafische Equalizer (nur CD 44)

2. Input Gains

3. Input Delay (nur CD 44)

4. Limit Reduction

5. Output Gain

6. Output Delay

7. Parametrische Equalizer

Die Verknüpfungen zwischen Master und Slave sind relativ, d.h. haben Master und Slave beim
einrichten des Links unterschiedliche Werte, so wird dieses Offset beibehalten, wenn der
Master seinen Wert ändert.

Das Offset kann im Slave auch nachträglich geändert werden.

Beispiel: Die Gaineinstellung des Masters beträgt bei Erstellung der Verknüpfung 0 dB, der
Slave ist mit +2 dB voreingestellt.

Wenn Sie nun den Wert des Masters auf +4dB erhöhen, erhöht sich die Einstellung des
Slaves ebenfalls um +4db auf +6dB. Der Offset beträgt also +2dB.

Ändern Sie die Gaineinstellung im Slave nun auf +7dB, beträgt das Offset künftig +3dB.

Das Offset wird zurückgesetzt, wenn Sie im Gerätefenster der Slaves [Link] » [reset] anklicken
oder im Fenster [Scenario] » [Linkmanager] » [resync] anklicken.

Die Slaves übernehmen somit den exakten Wert des Masters.

Ein Master kann kein Slave eines anderen Elementes werden.

Links werden nur auf dem PC gespeichert und sind im Controller nicht mehr aktiv, sobald
dieser von der Software abgemeldet wurde.

Anmerkung:

Wenn Sie in der Lautsprecher-Auswahl einen SEQUENZA-Lautsprecher gewählt haben,
werden im vierten Equalizer (EQ4) die Frequenz-, Qualitäts- und Gain-Werte für einen
Lowshelf-Filter aus dem entsprechenden LS-Block voreingestellt. Die Felder werden
ausgegraut und damit sind die Werte nicht mehr veränderbar.
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Bei Sequenza-Lautsprechern wird das Lowshelf-Filter über die Anzahl der Lautsprecher
bestimmt.

15.1 Funktionsblöcke verknüpfen

Sie können die Funktionsblöcke wie folgt verknüpfen:

1. Klicken Sie auf Szenario » Linkmanager.

Über die Dropdown-Liste 'View' können Sie festlegen in welcher Sortierfolge die
Funktionsblöcke angezeigt werden.

2. Wählen Sie zuerst [add link] für den Funktionsblock eines Gerätes, der als Master dienen
soll. Im folgenden Beispiel ist das der EQ 1 des Gerätes "Unit 1".

3. Es öffnet sich das Fenster "SlaveDialogs", in dem Sie einen oder mehrere Funktionsblöcke
auswählen können, die dem Master folgen sollen.

15.2 Verknüpfungen verwalten und löschen

Im Linkmanager haben Sie die Möglichkeit die Verknüpfungen zu verwalten:

Sie können mit

[add link] - eine neue Verknüpfung erstellen,

[show window] - das entsprechende Gerätefenster anzeigen,

[resync all slaves] - alle verknüpften Geräte auf die Einstellung des Masters zurücksetzen
(Offsets entfernen),
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[remove link] - Eine Verknüpfungsbeziehung löschen,

[resync slave] - Die Einstellung eines verknüpften Funktionsblocks auf die Einstellung des
Masters setzen (Offset entfernen).

Das nachstehende Beispiel zeigt zwei verlinkte Equalizer. Der Equalizer von Unit 1 ist Master.

Im Gerätefenster unter dem Eintrag Link wird angezeigt, ob es sich bei dem Funtionsblock
um einen Master oder ein Slave handelt. Bei Gerät 'Unit 1 / EQ 1' handelt es sich um einen
Master. Klicken Sie auf den Eintrag Master (rot), erscheint ein Fenster, das Ihnen anzeigt,
welche Geräte und Funktionsblöcke als Slave eingestellt sind.

Bei Gerät 'Unit 2 / EQ 1' handelt es sich um einen Slave. Unter dem Eintrag 'Link' wird
angezeigt, welches Gerät und welcher Funktionsblock als Master dient.

Klicken Sie im auf diesen Eintrag, dann können Sie über Reset die aktuellen Parameter des
Slaves mit denen des Masters überschreiben.

16. Szenarien

Sie können sämtliche Einstellungen aller geöffneten Controller, einschließlich der Setups,
Verknüpfungen und der Einstellungen der grafischen EQs, auf dem PC als Scenario
abspeichern.
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So können Sie die kompletten Einstellungen mehrerer Controller und geöffneter Fenster
in der gleichen Position und Größe schnell wieder aufrufen. Dies ist z.B. sinnvoll, wenn Sie
wechselnde Anlagenkonfigurationen bedienen wollen. Szenarien werden nur auf dem PC
gespeichert.

Wird ein Setup mit Current Setup » LoadFromFile aus einer Datei oder einem Szenario
geladen, so wird das aktuelle Setup überschrieben.

16.1 Szenario laden

1. Klicken Sie im Hauptfenster auf Szenario.

2. Klicken Sie auf LoadFromFile.

3. Wählen Sie die entsprechende Datei aus.

Daraufhin werden die Einstellungen aller im Szenario gespeicherten Controller azfgerufen
und alle gespeicherten Bedienelemente werden geöffnet. Werden ein oder mehrere
Controller aus dem Scenario nicht gefunden, so wird ein Fenster Missing Scenario Devices
angezeigt. Sie werden gefragt, ob Sie automatisch entsprechende virtuelle Geräte anlegen
möchten.

Klicken Sie auf Auto create Virtual Devices » Continue. Virtuelle Controller mit den Namen
der fehlenden Controller und den entsprechenden Einstellungen werden so automatisch
erzeugt.

Die im Szenario gespeicherten Controller werden durch ihre Namen identifiziert, nicht nach
Seriennummer oder IP-Adresse.

16.2 Szenario speichern

1. Klicken Sie im Anmeldefenster auf Szenario.

2. Klicken Sie auf SaveToFile.

3. Geben Sie den gewünschten Dateinamen ein, und klicken Sie auf Speichern.
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17. Arbeiten mit virtuellen Controllern (Offline Devices)

Die Software ermöglicht es Ihnen, Einstellungen an virtuellen Geräten vorzunehmen, um
diese Einstellungen später an existierende Controller zu übertragen. Das ist praktisch, wenn
Sie sich an einem anderen Ort als die Controller befinden, aber die Einstellungen schon
vornehmen möchten. Sie können die Offline Devices auch nutzen, um sich mit der Software
vertraut zu machen.

17.1 Virtuelle Controller erstellen

1. Starten Sie die Software. Klicken Sie auf Start » Alle Programme » Kling & Freitag CD 44
Remote » CD Remote.

2. Klicken Sie auf Offline Devices » Add.

3. Geben Sie dem virtuellen Controller einen Namen. Klicken Sie auf OK. Beachten Sie, dass
der Name aus nicht mehr als 15 Zeichen bestehen darf.

4. Danach werden Sie gefragt, ob Sie ein virtuelles Gerät mit oder ohne
Speichererweiterung erzeugen möchten. Das virtuelle Gerät sollte der tatsächlichen
Hardware entsprechen.

5. Schließen Sie das Fenster Offline Devices, wenn Sie keine Geräte mehr hinzufügen oder
entfernen möchten.
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6. Aktivieren Sie das Kontrollkästchen Offline. Das Gerätefenster öffnet sich und Sie können
Einstellungen an dem virtuellen Controller vornehmen. Wie bei einem existierenden
Controller können Sie alle Einstellungen erstellen, speichern und laden.

Erstellen Sie einen virtuellen Controller unter dem Namen eines realen Controllers, so
erscheint für beide Controller nur ein Gerät in der DeviceList. In diesem Fall können Sie durch
Aktivierung und Deaktivierung des Kontrollkästchens [Online], bzw. [Offline] zwischen den
Geräten wechseln.

Tipp

Bitte beachten Sie, dass Sie alle Einstellungen, die Sie ab jetzt an den realen oder virtuellen
Controllern vornehmen, nicht automatisch übertragen werden. Ändern Sie den realen
Controller, müssen Sie diese Änderungen speichern und in den virtuellen Controller laden.
Ändern Sie den virtuellen Controller, müssen diese Änderungen ebenfalls abgespeichert
werden, um sie dann in den realen Controller zu laden.

17.2 Virtuelle Controller löschen

1. Klicken Sie im Hauptfenster auf Offline Devices.

2. Wählen Sie den oder die zu löschenden virtuellen Controller im Fenster Offline Devices
aus.

3. Klicken Sie auf Remove.

4. Schließen Sie das Fenster Offline Devices.

17.3 Einstellungen zwischen virtuellen und realen Controllern
übertragen

Alle gespeicherten Einstellungen und Dateien aus virtuellen Controllern können Sie in reale
Controller laden. Ebenso können Sie alle Einstellungen und Dateien aus realen Controllern in
virtuelle Controller laden. Eine besondere Vorgehensweise ist nur bei Szenarien zu beachten,
die wir im Folgenden beschreiben:
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17.3.1 Szenarien virtueller Controller auf reale Controller
übertragen

Szenarien benötigen die Controllernamen der verwendeten Controller. Aus diesem
Grund müssen die Namen der virtuellen Controller mit den Namen der realen Controller
übereinstimmen.

Möchten Sie die Szenarien von virtuellen Controllern auf reale Controller übertragen, gehen
Sie wie folgt vor:

1. Erstellen Sie die gewünschte Anzahl virtueller Controller und nehmen Sie die benötigten
Einstellungen vor.

2. Klicken Sie im Anmeldefenster auf Szenario » SaveToFile Geben Sie der Datei den
gewünschten Namen. Klicken Sie auf Speichern.

3. Melden Sie die realen Controller in der Software an. Siehe Kapitel Software starten und
Controller anmelden auf Seite 16.

4. Für die realen Controller muss das Kontrollkästchen Online deaktiviert sein, für die
virtuellen Controller muss das Kontrollkästchen Offline aktiviert sein.
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5. Im Gerätefenster der virtuellen Controller:

Klicken Sie auf Device » Name.

6. Geben Sie den virtuellen Controllern den selben Namen wie den entsprechenden realen
Controllern, in unserem Beispiel "Unit 1" und "Unit 2" und bestätigen Sie die Eingabe
mit [OK].

7. Im Anmeldefenster (DeviceList) ist für den virtuellen und den entsprechenden realen
Controller jeweils nur noch ein Gerät aufgelistet.

8. Speichern Sie das Szenario mit Szenario » SaveToFile.
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9. Deaktivieren Sie das Kontrollkästchen [Offline] und aktivieren Sie stattdessen das
Kontrollkästchen [Online]. Durch diese Vorgehensweise wechseln Sie vom virtuellen
Controller auf den realen Controller.

10. Anschließend müssen Sie das Szenario über [Scenario] » [LoadFromFile] in den realen
Controller laden. Das Szenario, welches Sie virtuell erstellt haben, ist nun auf die realen
Controller übertragen.

Bitte beachten Sie, dass Sie alle Einstellungen, die Sie ab jetzt an den realen oder virtuellen
Controllern vornehmen, nicht automatisch übertragen werden. Ändern Sie den realen
Controller, müssen Sie diese Änderungen speichern und in den virtuellen Controller laden.
Ändern Sie den virtuellen Controller, müssen diese Änderungen ebenfalls abgespeichert
werden, um sie dann in den realen Controller zu laden.

18. Update der CD Remote Software

Laden Sie die aktuelle Software aus dem Downloadbereich der Website von Kling & Freitag
herunter (www.kling-freitag.de).
Kopieren Sie die Datei CD Remote Installer Vx-xx.zip auf Ihren PC. Entpacken Sie die
Datei und starten Sie mit einem Doppelklick auf CD 44 Remote Installer VX-XX.exe . Das
Setup Programm sorgt für die Deinstallation der vorherigen Version. Sollte die installierte
softwareversion identisch mit der des Installers sein, haben Sie die Wahl, ob Sie die
vorhandene Installation reparieren oder deinstallieren möchten.

Geräte mit Speichererweiterung können nur mit einer CD 44 Remote Software angesprochen
werden, deren Version größer 1.4.3 ist!

Ab der Softwareversion größer als V1.2.876 kann nicht mehr auf den CD 24-Controller
zugegriffen werden. Sollten Sie diese Programmversion benötigen, steht diese auf unserer
Intersetseite als Download zur Verfügung.

Für den Zugriff auf einen CD 44 Controller sollten Sie die aktuelle Version der CD 44 Remote
benutzen.

Tipp

Hinweis für SEQUENZA 10 N/W Nutzer:

Gilt nur für ein Update von einer Softwareversion kleiner 1.3 auf Version 1.3 oder höher!

Nach dem Laden eines 'Complete-Backups' befinden sich SEQUENZA 10 N/W Speakers
(LSBlocks) im Controller, die nicht über den vollen Bedienkomfort verfügen. Dieser bietet die
Möglichkeit SEQ LShelv Filter über die Anzahl der verwendeten Lautsprecher automatisch
einzustellen. Siehe Kapitel Parametrische Filter auf Seite 36.

Um dieses Feature zu bekommen, haben Sie die Möglichkeit die entsprechenden
Lautsprecher-Setup zu aktualisieren.

Eine Aktualisierung der Lautsprecher-Setups zur Erweiterung des Bedienkomforts ist
notwendig, wenn die Revisionsnummer der 'SEQ Speakers' kleiner al 1.4 ist.

Sie finden die Revisionsnummer ihrer Lautsprecher im Gerätefenster in der Spalte [Rev].
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Ohne eine Aktualisierung der 'Sequenza Speakers', müssen Sie die SEQ LShelv-Filter für
SEQUENZA 10 N/W Lautsprecher manuell einstellen. Siehe dazu die entsprechende Tabelle im
Kapitel [Parametrische Filter 'PEQ' + SEQ LShelv (Filter A Taste)] des Hardware Manuals für
den Controller.

Um die Aktualisierung der 'SEQUENZA 10 N/W Speakers' (LSBlocks) vorzunehmen, gehen Sie
wie folgt vor:

• Starten Sie die Software.

• Melden Sie die realen Controller in der Software an.

• Klicken Sie im Gerätefenster auf Current Setup » Load From File.

• Laden Sie die Datei SEQ LS Update.dsc. Der voreingestellte Dateipfad, in der sich die
Datei nach der Installation befindet, lautet: 'Eigene Dateien, bzw. gemeinsame Dateien
\Kling & Freitag\CD Remote\CD44 Setups\'

• Bestätigen Sie 4 mal mit OK, um alle alten Speakers (LSBlocks) zu überschreiben.

• Damit ist die Aktualisierung abgeschlossen.

18.1 Verwendung des CD 44-AutoUpdaters

Der CD 44-AutoUpdater ermöglicht Ihnen, alle Komponenten Ihres CD 44 auf dem aktuellen
Stand zu halten. Neben den Updates für Ihre K&F-Software werden je nach Einstellung
des Programms, entweder automatisch oder manuell, auch die neuesten LS-Blöcke
auf Ihre Festplatte übertragen. Nach der Beendigung des Vorgangs können Sie die LS-
Blöcke wie gewohnt auf Ihren CD 44-Controller übertragen. Auf diese Weise bleiben Ihre
Lautsprecherblöcke aktuell.

Nach der Installation können Sie das Hauptprogramm aus dem "Kling & Freitag"-
Ordner im Startmenü starten. Wenn Sie das Programm zum ersten Mal ausführen, wird
ein Startbildschirm gezeigt. Über die Schaltfläche des Startbildschirms können Sie das
Updateintervall und ihre bevorzugte Sprache festlegen.

18.1.1 Updateintervall bestimmen

Folgende Optionen stehen Ihnen als Updateintervall und Sprachauswahl zur Auswahl:
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Möchten Sie kein Zeitintervall angeben und die Option "nie" wählen, sollten Sie den
Aktualisierungsvorgang mit dem Startmenüeintrag "Check for Updates" im Verzeichnis
"Kling & Freitag" von Zeit zu Zeit manuell starten.

Wir empfehlen das voreingestellte Intervall von "bei jedem Programmstart" zu übernehmen.

18.1.2 Updateverlauf

Achten Sie vor dem Starten des Updates darauf, dass Ihr Computer mit dem Internet
verbunden ist.

Im weiteren Verlauf des Updates werden Sie möglicher Weise dazu aufgefordert, sich als
Administrator anzumelden. In Windows 7 beispielsweise brauchen Sie nur den angezeigten
Administrator-Hinweis bestätigen und das Update wird ohne weitere Systemmeldungen
vervollständigt.

Wenn die Aktualisierung gestartet wurde, wird zuerst eine Update-Suche und
ein Versionsabgleich des Programms und der bestehenden LS-Blöcke mit unserem
Firmenserver durchgeführt. Sie werden in dem Infofenster über das Suchergebnis und den
Versionsabgleich informiert.

Wenn Sie Veränderungen an dem K&F-Systemordner ("C:\Program Files (x86)\KlingFreitag\CD
Remote\") vorgenommen haben, wird der Ordner zu einem Archivordner umbenannt und ein
neuer Ordner mit den neuen Updates erstellt.



Benutzerhandbuch K&F CD 44 Remote

KLING & FREITAG GMBH © 2014 Version 5.5 Seite 51 von 56

Der eigentliche Updatevorgang dauert im Normalfall nur wenige Sekunden. Sollten zu
den neuen LS-Blöcken Kommentare geschrieben worden sein, werden diese im Infofenster
angezeigt und in einer Protokolldatei gespeichert.

Wenn neue LS-Blöcke auf Ihre Festplatte kopiert wurden, werden Sie im Infofenster darüber
informiert, wo auf Ihrem Rechner eine Protokolldatei mit welchem Namen gespeichert
wurde.

Wenn das Update erfolgreich beendet wurde können Sie wie gewohnt die LS-Blöcke auf
Ihren CD 44-Systemcontroller übertragen und die K&F Software benutzen.

19. IP-Karte tauschen und Firmwareupdate

19.1 Sicherheitshinweis

Warnung

Es dürfen nur die Arbeiten am geöffneten Controller vorgenommen werden, die in
diesem Handbuch beschrieben sind (Austausch der "IP-Karte"). Insofern wird von der
entsprechenden Regelung in den AGB abgewichen.

Diese Arbeiten dürfen aufgrund der Komplexität von elektrischen Schaltungen nur von in
der Elektrotechnik geschultem Personal durchgeführt werden. Ansonsten ist die Sicherheit
der Produkte nicht gewährleistet.

Ziehen Sie vor dem Öffnen des Controllers den Netzstecker.

19.2 IP-Karte tauschen

Nur CD 44!

1. Entfernen Sie die vorderen und hinteren Schrauben an der linken Seitenwand des
Controllers mit einem 2-mm-Inbusschlüssel.

2. Lösen Sie die vordere und hintere Schraube an der rechten Seitenwand des Controllers.
Diese Schrauben müssen nicht ganz entfernt werden.

3. Nehmen Sie das linke Seitenteil ab und ziehen Sie den oberen Deckel des Controllers ca.
10 cm nach links.
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Die IP-Karte steckt senkrecht hinter dem Ethernetanschluss. Sie erkennen eine neue Karte
an der vorhandenen Versionsnummer auf der Rückseite.

4. Ziehen Sie die alte Karte senkrecht nach oben heraus und setzen Sie die neue Karte ein
(Version V4.0 oder höher).

5. Achten Sie darauf, dass die neue Karte fest in dem Slot sitzt.

6. Schieben Sie den Deckel wieder zu.

7. Setzen Sie das Seitenteil wieder ein. Achten Sie darauf, dass die Führungsschiene nach
unten zeigt.

8. Ziehen Sie die Schrauben wieder an.

19.3 Firmwareupdate durchführen

WICHTIGE INFORMATION VOR DEM START DER FLASHLOADER SOFTWARE !

Durch das Update wird die Firmware (Betriebssoftware) neu in den Controller geladen.
Während dieses Vorgangs darf es zu keinerlei Unterbrechungen kommen, da im
ungünstigsten Fall der Controller anschließend nicht mehr funktioniert.

Überprüfen Sie, welches Gerät sie genau updaten wollen. Notieren Sie sich beim CD 44
folgende Daten:

• Gerät ohne Speichererweiterung

• Gerät mit Speichererweiterung (äusserlich am '192' Logo zu erkennen, Standard)

• dessen aktuelle IP Adresse

Stellen Sie sicher, dass

• alle Kabel sicher stecken und während des Downloads nicht entfernt werden.

• der Computer keine anderen rechenintensiven Programme ausführt.

• das Update nicht über eine Ethernet-Verbindung erfolgt, in der große Datentransfers
anderer User stattfinden. Wenn möglich, verwenden Sie eine direkte Verbindung zum
Computer.

Haben Sie eigene Setups oder EQ-Sets erstellt, so sichern Sie diese vor dem Firmwareupdate
auf Ihrem PC. Siehe Kapitel Speicherverwaltung des Controllers (Memory Organization) auf
Seite 26.

Speichern Sie dafür nicht mit Complete ein 'Complete Backup' des Controllers. Würden Sie
nach einem Update dieses Backup laden, würden wichtige, aktualisierte Dateien von den
veralteten Dateien überschrieben. Dies gilt besonders für die Lautsprecherblöcke und die
Input-Patchings.

Nach dem erfolgreichen Firmwareupdate müssen Sie die aktuelle Version der Datei CDX4
Complete Defaults VX-XX.dcc laden, damit das erweiterte Input-Patching richtig verwaltet
wird und ihnen aktualisierte Speakers (LSBlocks) zur Verfügung stehen.

Firewall
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Stellen Sie Ihre Firewall so ein, dass der Flashloader nicht blockiert wird.

19.3.1 Download Firmware

Sie können eine Datei mit der aktuellen Version der Firmware von der Kling&Freitg-Website
herunterladen (www.kling-freitag.de).

19.3.2 Flashloader starten

Tipp

Bitte beachten Sie, dass bei neueren Revisionen das Update ein wenig von der hier
beschriebenen Weise abweichen kann. In diesem Falle werden Sie von dem Flashloader über
einen Dialog durch das Update geführt.

Der Flashloader für das Firmwareupdate ist im Installationspaket der Remote-Software
enthalten.

1. Klicken Sie auf Start » Alle Programme » Kling & Freitag CD 44 Remote » Flashloader.

2. Aktivieren Sie UDP Settings und wählen Sie die entsprechende IP-Nummer aus.

Die IP-Adresse ist die bei der Auslieferung der Controller voreingestellt. Haben Sie die
Adresse im CD 44 geändert, so müssen Sie hier die entsprechende Adresse eintragen.

3. Klicken Sie auf OK.

4. Nachdem der Controller erkannt wurde, klicken Sie auf [Load].

5. Wählen Sie die Datei deren Name mit „CD44Firmware“ beginnt. Bei Geräten mit
Speichererweiterung verwenden Sie die Datei, die mit '_192' endet.

Wenn Sie mehrere Dateien für einen Controller zur Verfügung haben, wählen Sie die mit
der höchsten Versionsnummer.



Benutzerhandbuch K&F CD 44 Remote

KLING & FREITAG GMBH © 2014 Version 5.5 Seite 54 von 56

6. Klicken Sie auf Öffnen und anschließend auf Download.

Daraufhin werden zwei Dateien installiert. Das Display des Controllers zeigt bootloader...
an. Der Transfer nimmt ca. vier Minuten in Anspruch. Nach Installation der ersten Datei
startet der Controller neu und zeigt kurz das normale Display. Nach ca. zehn Sekunden
startet der Download der zweiten Datei und im Display des Controllers wird wieder boot
angezeigt.

Nachdem die zweite Datei installiert wurde, zeigt der Controller wieder sein normales
Display. Das „Download“-Fenster verschwindet und es wird „download finished“
angezeigt.

7. Schließen Sie die Flashloader Software.

8. Schalten Sie den Controller aus und wieder ein (Netzstecker ziehen und wieder
einstecken).

9. Nach dem erfolgreichen Firmwareupdate müssen Sie die aktuelle Version der Datei
CDX4 Complete Defaults VX-XX.dcc laden, damit das erweiterte Input-Patching richtig
verwaltet wird und ihnen aktualisierte Speakers (LSBlocks) zur Verfügung stehen. Anders
als in Ihrer alten Version wird jetzt in den Setups auch das Input-Patching abgespeichert,
also auch Analog bzw. Digital. Siehe Kapitel Speicherverwaltung des Controllers
(Memory Organization) auf Seite 26.

Jetzt kann der Controller mit der Remote-Software bedient werden.

Tipp

Wird der Controller nicht gefunden, schließen Sie die Flashloader Software und ziehen Sie
am Controller kurz den Netzstecker. Starten Sie die Flashloader Software erst, wenn der
Controller „hochgefahren“ ist.

Wird der Download der zweiten Datei nicht nach spätestens 30 Sekunden fortgesetzt,
muss die Flashloader Software mit dem Windows Taskmanager beendet werden und der
Controller muss einmal kurz vom Netz (Controller aus- und wieder einschalten) getrennt
werden. Kontrollieren Sie, ob wirklich die richtige IP-Karte im CD 44 steckt. Starten Sie die
Flashloadprozedur erneut.

Falls im Fenster 'Flashloader' „no device found“ angezeigt wird, können Sie das Update nicht
starten. Klicken Sie in diesem Fall nicht auf den Download-Button, sondern beenden Sie das
Programm über den Task-Manager. Stellen Sie zunächst die Verbindung mit dem Controller
her und starten Sie die Prozedur erneut.

Falls Ihr Gerät in seinem Display 'wrong firmware' anzeigt, haben sie versehentlich die
falsche Firmware ausgewählt (siehe Schritt 5 und 6). Beginnen Sie die Prozedur mit korrekter
Firmware wieder bei Schritt 1.
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